INTE 2014

Innovations in ethical education: dilemmas in theory and practice

Petra Fridrichova*

Matej Bel University in Banská Bystrica, Cesta na amfiteater 1, 974 11 Banská Bystrica, Slovakia

Abstract

Ethical education in Slovakia is based on project of education to prosocial behaviour which was created by R. R. Olivar from Spain. Its starting point is the development of sociability through a specific educational program, parenting style, and through specific methods. The study aims to identify opportunities of innovation in ethical education. The starting point is analyses of actually theoretical concepts of innovation in ethical education (innovation model of ethical education teaching, competence profile of ethical education teacher, content innovation of ethical education). Analysis is confronted with educational practice and view teachers the current state of ethical education and its perspectives.

Keywords: Innovation of ethical education, content innovation of ethical education, competence profile of ethical education teacher, theoretical concepts of ethical education innovation

1. The current situation in the conception of ethical education in Slovakia

Ethical education in Slovakia proceeds from an educational project of pro-sociability created by R.R. Olivar. Its basis is the development of pro-sociability by means of a specific educational programme, educational style and specific methods. Ethical education is composed of ten foundational themes (open communication, human dignity, positive self-evaluation and positive evaluation of others, expression of emotions, empathy, assertiveness, real and figurative role models, creativity and initiative, helping – giving – sharing – pro-social behaviour, comprehensive pro-sociability) and six application themes (ethics – looking for the roots of pro-social behaviour, my family; ethics and economic values; ethics and religions; marital and parental education; environmental protection). The foundational themes represent a kind of overview of the personality and social skills acquired by a person who is able to:

* Corresponding author. Tel.: +421 918 617 215
E-mail address: petra.fridrichova@umb.sk

1877-0428 © 2014 The Authors. Published by Elsevier Ltd.
Peer-review under responsibility of the Sakarya University.
- Live according to moral principles and ethics,
- Reach some level of self-reflection, self-development and self-management,
- Create and maintain healthy and positive interpersonal relations,
- Create and maintain a healthy, stimulating and non-threatening life environment.

The application themes represent a super-structural concept. The main idea of this concept is a confirmation of the morals and ethics in complex life-related themes. Progressively pupils are asked to explore the essence of pro-social behaviour not only in ethical but also in religious concepts, the link between ethics and economics, family life, sexual activity, and parenthood, as well as man’s impact on his living environment or recognition of one’s own abilities to contribute to sustainable development. It might seem that mastering the application themes is determined by an adequate knowledge of the foundational themes, but the State Educational Programme of the Slovak Republic Appendix Ethical Education (2011) does not support such a conclusion. An example of this is the topic my family or Environmental protection: they already appear at primary school level.

In the introduction to our paper we focused on a brief description of ethical education in Slovakia as characterized by the concept authors – R. R. Olivar and L. Lencz (1992). Ethical education has been accompanied by several problems and discussions since its formation. One of the recurring questions is the interchanging of ethical and religious education. A political decision, on the basis of which pupils may choose either ethical or religious education, led to the creation of two areas in Slovakia, (Eastern Slovakia, Kysuce and the Orava regions), where ethical education is not taught at all. Another question (of equal importance to ethical education practice) is an uncompleted and non-evaluated experiment that could have pointed out which methods and strategies are appropriate for a particular age group or a particular topic. Although ethical education’s problems originated in the period when the subject was formed they are still relevant. We think that it is necessary to innovate and update the objectives and content of ethical education in relation to the social situation. This is the reason we decided to examine current perspectives on theoretical concepts of innovations in ethical education and to compare them with the possibilities of teachers themselves applying them to educational practice.

2. Theoretical concepts of innovations in ethical education in Slovakia

There was some research in 2006-2010 in the Faculty of Education, at Matej Bel University, which focused on a comparative analysis of ethical education in the international context. It was the basis for identification of conceptual tendencies in ethical education or equivalent subjects in Europe. It was precisely this innovative direction of moral, personal and social education concepts that formed the basis for the ethical education innovation in Slovakia that extends to several areas:

- Content innovation,
- Innovative teaching model,
- Competency profile of an ethics teacher (Note: this model is not analyzed in our paper).

The content innovation of ethical education stemmed from the need to update the subject in relation to social change. The basis for the adjustments was the identification of key values to which the current concept of ethical education leads (more in Valica-Fridrichová, 2011). In primary education (ISCED 1) the aim of ethical education is a realization of the importance of friendship for self-development, for the creation and maintenance of good interpersonal (friendly) relationships, and for the understanding of moral principles. In lower secondary education (ISCED 2) the aim of ethical education is the development of responsibility. Initially, (in correspondence with the great diversity in age among pupils in lower secondary education), responsibility for oneself and one’s own actions develops, in terms of the creation and maintenance of good friendly relationships, later it is understood in terms of social responsibility. In higher secondary education (ISCED 3), the core “value” of ethical education is morality, which should be interwoven with all components of life be it personal, social, as a partner or professional. Defining the key values of ethical education in individual classes is considered to be the main precondition for innovation of content for this subject as they indicate the goal of ethical education at the various educational stages (ISCED 1 – ISCED 3).

Another level of content innovation was to identify current social topics that so far are not included in the ethical education curriculum. The reason for their absence is first and foremost the period of time when the national curriculum of this subject was formed (for ISCED 2 and 3 it was in the 1990s of the 20th century, for ISCED 1 at
the beginning of the new millennium) when many contemporary topics were not considered to be priorities of moral education at that time. More than twenty years later, however, topics that were not emphasized in the past (sustainable lifestyle, the technology boom and the related media pressure, ecological and environmental threats, religious tolerance, global terrorism, etc.) became crucially important to contemporary society.

We have not expanded the content of ethical education, but have tried to point out how is it possible to enrich the foundational and application themes with some current problems: media education, eco-ethics and global development education.

The topic, which seemed to be necessary at all levels of education, is media education. E. Balážová (2012a, 2012b) speaks in more detail about its aspects in relation to extending ethical education. The impetus for connecting media and ethical education became the prevention of cyber bullying, education in values in the virtual world, the ability to critically evaluate media content and consequently to choose appropriate programmes for self-development without putting in jeopardy one’s own moral values. Another current topic for secondary education was to elaborate on the issues of eco-ethics. J. Kaliský (2013) writes about its basis and its relation to ethical education. The reason for its integration was education in sustainable lifestyles. The content of primary education was influenced the most. Within this framework we connected individual (apparently isolated) topics through reflection on friendship. It is quite difficult for pupils of early school age to understand the philosophy and nature of topics such as empathy, assertiveness, human dignity, open communication, or prosociability. They are able to process concepts which are closer to their way of thinking, for example explaining these topics in terms of friendship, behaviour towards peers and older people by whom they are surrounded. We presumed that an increased emphasis on the principle of concrete examples in abstract topics would enable teachers to plan ethics classes in such a way that pupils would naturally learn the social skills they are either losing or not developing to a full extent because of an increased use of the internet and virtual communication. Another level of content innovation for primary education was the integration of selected topics of global developing education in ethical education (more in Frídrichová, 2012). The objective of integrating these topics is to accelerate a tolerance of diversity among younger pupils (also by means of cognition of rights and obligations), to strengthen their willingness to help those in need and to become more sensitive to socio-wide problems.

The content innovation of ethical education does not interfere with the range of these subject topics. At its base is simply support of those areas that seem to be vital for contemporary moral education, on the basis of the acceptance of the current content and objectives of ethical education.

The innovative model of ethical education was detailed in three main areas: pupils’ pedagogical diagnostics, didactics and methodology of ethical education and action research. Inclusion of pedagogical diagnostics and action research in the model of ethical education teaching was supported by the presupposition that it is important to know their current state (pedagogical diagnostics) to plan personal and socio-moral development of pupils, and by proposing, carrying out and evaluating content and methodological innovative interventions (action research) we can change this state. The teaching model was revised primarily in the didactical and methodological sections. The basis of the change was the planning of ethical education based on a pro-active teaching model. Therefore, we focused on the creation of objectives and educational requirements in cognitive and affective (attitudinal) areas and subsequently on the creation of tasks focused on pupils’ learning in the context of the established goals. The specific area of the ethical education teaching model was an elaboration of a number of methods and techniques of drama classes, methodology of games, methods of solving moral dilemmas, as well as discussion methods in relation to cognition of their roles in the process of ethical education in its individual phases (cognitive and emotional sensitization, reflection of values, class training, transfer to everyday conditions). A separate task of the methodological innovation of ethical education was to strengthen the utilization of literary, musical and visual arts for the development of the pupils’ moral consciousness by their application in foundational and application themes (more in Šimonová, 2012; Lucinkiewiczová, 2012; Felix, 2012, 2013). The last of the innovative interventions was the elaboration of evaluation methodology in ethics classes, which is closely connected with pedagogical diagnostics and an operationalized choice of objectives geared towards the pupil.
3. Innovation of ethical education from the teachers’ point of view

The basis for the later verification of theoretical concepts of ethical education innovations in pedagogical practice was the education of teachers in two areas: expert competences and psycho-didactical and research competences. The goal of the first programme, focused on the development of expert competences, was to strengthen knowledge about media education, literary, musical and visual arts for all teachers (ISCED 1 – ISCED 3), about religions, economics, ethics, as well as eco-ethics for teachers in secondary education (ISCED 2 and 3); assertiveness and empathy as parts of friendship, and about the global development of teachers’ education in primary education (ISCED 1). On the basis of education carried out, teachers prepared opportunities for ethical education content innovations according to a topic chosen for the particular year. We compared the innovation opportunities proceeding from teachers’ real experience with theoretical suggestions for content expansion in particular topics. In general, we can state that while in the theoretical concepts authors suggested the content expansion almost in all thematic units of ethical education specified in the National Educational Programme for Ethical Education (2011), teachers’ innovations were more differentiated and we can divide them to three groups. The first group consists of teaching innovations similar to theoretical suggestions and dealt with all topics of ethical education. Such suggestions were connected with the integration of media, global developing education or with the application of arts. We assume that these topics were new for teachers and so they were unable to identify with any of the current thematical units. This gave them an opportunity to experiment with new dimensions in traditional topics of ethical education. The second group was composed of innovations by teachers, which focused only on the foundational themes of ethical education. They were related mainly to the primary educational process of ethical education: empathy, assertiveness, communication, and positive evaluation of others. Teachers rarely found links between different areas suggested for innovation and application themes, or thematical units of ethical education. Another problem arose because teachers did not find a common denominator in empathy, friendship, positive evaluation or communication: namely friendship, which would have interwoven all of the themes and developed this aspect of ethics in primary education. The third group of teachers are those who focused on the content innovation of application themes. Innovation, or to be more precise, extension of the basic curriculum, was limited to the elaboration of the application theme (for example, ethics and economic values, ethics – looking for the roots of pro-social behaviour, ethics and religions, etc.) in its elementary connotations. We presume that the main problem of this teachers’ group, which was trained mainly at methodology and pedagogy centres (almost 90 % of the teachers involved), is the fact that they do not know anything about application themes. Before participating in our training, these teachers had a significant lack of knowledge about the individual application themes, so the elaboration of their themes was innovative from their own point of view (they worked out on a theoretical level a topic previously unknown to them in order to create conditions for pupils’ active learning in these areas). Content innovation was the first step in the innovation process of ethical education. However, we were striving also to innovate education in terms of pro-active learning through the development of teachers’ didactic competences. Many indicators of the efficiency of this model are not yet processed because at the present time teachers are completing its verification. Provisional results indicated several problematic spheres of educational innovation:

- Teachers whose content innovation was only on the level of a deeper elaboration of already known and frequently taught themes (empathy, assertiveness, communication, positive evaluation): in educational planning they did not respect the strategy of ethical education and their lessons had a transmissive rather than pro-active model. Teachers were not pointing out the value of friendship manifested by such social skills as empathy, assertiveness, open communication, etc. Lessons took the form of practice or training in these social skills. In this group of teachers the applicability of the theoretical model was not proved in educational practice.

- Teachers whose content innovation was interwoven with the whole curriculum of ethical education: the educational projects created were focused on development of critical thinking through self-discovery and self-cognition through learning. Teachers alternated different educational methods, applied ethical education strategy and implemented value reflection. The only deficiency in these educational projects was
the absence of evaluation criteria. The applicability of the theoretical model of ethical education was proved.

- Teachers who used art as a mean of achieving the objectives in their educational practice: the main deficiency of these groups was an inadequate differentiation between the means and goals of the education process. They perceived the reading of fairy tales, the deciphering of an illustration or work of art as an objective of the educational process, not as a means of moral education. Those who began to perceive the difference created lessons based on art and headed towards the fulfilment of the subject objectives through various additional tasks, using various educational methods (for example positive evaluation of others, open communication, tolerance, etc.). Such lessons met pro-active learning principles and also allowed the teacher to develop pupils’ positive attitudes. On the other hand, teachers who put the objectives of art first had problems with their lessons planning, a fact which became apparent in the structure of individual lessons. Teachers primarily achieved the goals of literature, music or art, but the objective of ethical education kept a low profile. On the basis of this experience we can state that the methodology innovation of ethical education through art as a means of moral education is risky because teachers are sidetracked to develop aesthetic, not ethical feeling.

4. Conclusions or ethical education perspective

We can sum up that the theoretical concepts of ethical education innovations have some strong, as well as weak points. However, the basis for innovation in any context is a well-prepared teacher who has expert, didactic and personal competences making presuppositions for:

- Bringing up to date and improving ethical education content according to social change;
- The educational process developing pupils’ ability to reflect on their own behaviour and adjust it in terms of ethics;
- Teacher’s self-development.

Ethical education is not a subject that would provide a general manual on how to make the world better or more moral. The concept of it, valid not only as it relates to this subject but also to other value-oriented subjects, helps pupils to see the world in a more complex way, reflect upon their actions and find various alternatives of how to respond in everyday situations.

This work was supported by the Slovak Research and Development Agency under contract No. SRDA-0690-10.

References


Instructions to Authors for Word template

1. Locking of Copyright:

The copyright line is locked in the Procedia templates. The author may not edit the same and making it editable only PSMs. If there are any copyright changes required, you are requested to contact Journal Manager through Guest Editors. For editable the below mentioned steps must be followed:

Steps:
- Click on copyright statement
- Click on Properties in Developer tab
- Remove the checks from Content control cannot be deleted and Contents cannot be edited under Locking and then Press ok

2. Docm format:

We have added macros in the Word templates for the below mentioned features. And since macros are not supported in doc and docx format we created the templates of all Procedia titles in .docm format.

- Removal of all highlights
- Accept track change
- Locking of Rules

If .docm format needs to convert in docx format then the following steps must be performed:

Steps:
- Press Alt F11
- Click on Project (JID_Template)
- Enter "thomson" in Project Password
- Click on Microsoft Word Objects
- Click on ThisDocument under Microsoft Word Objects
- Delete all macros under General
- After deletion close the Code and Project (JID_Template) windows
- From File menu click on save as type .docx option

3. Comments added in the margin in Word master templates:

There are instances where author raising queries on what to do with key information lines such as “volume, page numbers”, “Conference title per issue” and “Copyright entity, year, copyright company Elsevier Ltd./B.V./Inc. and Organizer Name” in the copyright statement and for these concerns the comments have been inserted in the Word template to guide Author/JM about the information to be inserted by them in these fields.

Comments removal from Print: In Word 2007 and 2010 the comments present in a document get printed by default. If the authors do not want to get the comments appearing in print, the authors must remove the comments from the Word template before printing by changing the Print markup setting of word using the following steps:

Steps:
- Click the File tab
- Click Print
- Under Settings, click the arrow next to Print All Pages
- Click Print Markup to clear the check mark
Instructions to Authors pages to be excluded from Print:
- Click the File tab
- Click Print
- Under Setting, Type page numbers and/or page ranges separated by commas counting from the start of the document or the section. For example, type 1, 3, 1-5

4. PDF creation from Word master template:

While creating PDF from Word template the below given steps should be followed to avoid difference in trim size and margins and to avoid decrease in resolution and size of the figure images of the Word template and the PDF created.

Steps in Word 2007 and 2010:
- Click the File tab
- Click Print
- Under Printer tab, select Adobe PDF
- Click Printer Properties link
- Under Adobe PDF Settings tab, click on Edit button
- Click on Images folder under Standard
- Make Downsampling and Compression fields under Color Images and grayscales Images "Off". And in Monochrome Images field make only Downsampling "Off"
- Then click on OK and given name of the setting in File name tab and click on save
- Then again Under Adobe PDF Settings tab, click on Edit button
- Then click on Color folder
- Choose Leave Color Unchanged option under Color Management Policies tab then click on OK
- Lastly click on OK in Adobe PDF Settings tab
- Click Save As
- Under Save as type, click the arrow next to PDF (*.pdf)
- Click Save

In Word 2003 the PDF can be created by using “Convert to Adobe PDF” symbol in tool bar or the required paper size can be adjusted in the Adobe PDF settings given in the Properties tab on the Print option. Please follow the above steps to avoid decrease in resolution and size of the figure images.

5. Reference styles used in Procedia master templates:

<table>
<thead>
<tr>
<th>Title</th>
<th>Reference style</th>
</tr>
</thead>
<tbody>
<tr>
<td>AASPRO</td>
<td>2 Harvard</td>
</tr>
<tr>
<td>AASRI Procedia</td>
<td>3 Vancouver Numbered</td>
</tr>
<tr>
<td>APCBEE Procedia</td>
<td>3 Vancouver Numbered</td>
</tr>
<tr>
<td>EGYPRO</td>
<td>3 Vancouver Numbered</td>
</tr>
<tr>
<td>FINE</td>
<td>2 Harvard</td>
</tr>
<tr>
<td>IERI Procedia</td>
<td>3 Vancouver Numbered</td>
</tr>
<tr>
<td>MATPR</td>
<td>1a Numbered without article titles</td>
</tr>
<tr>
<td>MSPRO</td>
<td>2 Harvard</td>
</tr>
<tr>
<td>PHPRO</td>
<td>2 Harvard</td>
</tr>
<tr>
<td>PIUTAM</td>
<td>3a Embellished Vancouver</td>
</tr>
<tr>
<td>Procedia CIRP</td>
<td>3 Vancouver Numbered</td>
</tr>
<tr>
<td>PROCHE</td>
<td>3a Embellished Vancouver</td>
</tr>
<tr>
<td>PROCS</td>
<td>3a Embellished Vancouver</td>
</tr>
</tbody>
</table>